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Module 3 - Applications and Balancing Items

ViewDirect-ABS 4.1 
Course Outline

ViewDirect-ABS Training Modules

1. Introduction
2. Balancing Concepts
3. Applications and Balancing Items
4. Creating Rule Procedures
5. Results, Reports, and External Actions
6. Production Mode
7. Advanced Topics 
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Applications and Balancing Items 
Module Objectives

Upon completion of this module, you should be able to:

Create and edit applications and folders.

Describe the behavior of cycles and runs.

Describe cycle types and cycle advancing types.

Create and edit balancing items.

Create a folder.
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Applications and Balancing Items 
Introduction

ViewDirect-ABS operations depend 
on the following structure:
Application

Controls frequency and method of 
updating cycles.
Contains one or more balancing 
items.

Balancing Item
Identifies data sources. 
Links data sources with one or more 
rule procedures.

Rule Procedure
Contains detailed balancing 
instructions.
Extracts and processes data. 

ApplicationApplication

Balancing ItemBalancing Item

Balancing ItemBalancing Item

Rule ProcedureRule Procedure

Rule ProcedureRule Procedure

Rule ProcedureRule Procedure
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Applications

Balancing or reconciling is not something you do once and forget 
about it! Typically, if you need to balance your accounts for one 
month, quarter or year, you’ll need to balance the next one as well!
For this reason, in ViewDirect-ABS, you must group all balancing 
items in a container, called an application, that defines the 
frequency or pattern – the cycle – for running the balancing 
operation.

Applications

Balancing Items
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Applications 
Cycle Properties

An application determines the behavior of the balancing items it 
contains through two key properties:

The Cycle Type determines the frequency or pattern for running the 
balancing items. The Cycle Type can be based on dates (yearly, 
monthly, weekly, and so forth) or simple increments or versions.
The cycle Advancing Type determines the method for updating the 
cycle. The Automatic method declares a new cycle based on the 
date; the Programmatic method defines a new cycle based on 
rules in the rule procedure; the Manual method waits until the user 
opens the application’s properties dialog box and clicks the 
Advance Cycle button.

The combination of these application cycle properties give you 
the flexibility to determine how often and under what conditions to 
execute your balancing operations.
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Applications 
Planning Your Applications

In ViewDirect-ABS, you must first create one or more applications, 
and then create the balancing items under the applications that 
control their cycles.
As you plan your balancing and reconciling operations, keep 
these guidelines in mind:

You can create many applications with different cycle patterns.
You can have many balancing items under one application.
All balancing items under a single application follow that 
application’s cycle pattern exactly. Any variation requires a 
separate application.
For example, if you have two monthly automatic balancing items, 
but one is updated on 1st of the month while the other is updated 
on the 15th, they require two separate applications.
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Applications 
Creating an Application

Establishing an application 
involves two steps: creating it, and 
editing it to add more information.
To create an application, perform 
the following steps:
1. Either click the File menu or 
right-click the Applications node in 
the tree, and select 
New|Application.
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Applications 
Creating an Application

The Application Properties panel 
for a new application appears.
When first created, applications 
include the following properties:

Name
Description
Starting Date
Cycle Type
Advancing Type
Retention Period and 
Expiration Date

Define these fields as follows…
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Applications 
Creating an Application

2. In the Name field, enter a 
short name (no spaces) for 
the type or cycle pattern of 
the balancing items you will 
group in this application.

3. In the Description field, 
enter a longer description or 
explanation of the 
application’s contents.
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Applications 
Creating an Application

4. For the Starting Date field, 
today’s date appears as a 
default, but you can enter 
any valid date or click on 
the calendar icon to select 
a date from a calendar. 

For applications whose 
Advancing Type is Automatic, 
ViewDirect-ABS increments the 
application cycle based on the 
Starting Date.
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Applications 
Creating an Application

5. For the Cycle Type, select 
one of these options:

Annual
Quarterly
Monthly
Bi-Weekly
Weekly
Daily
Version
Incremental

(More on this shortly…)
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Applications 
Creating an Application

6. For the Advancing Type, 
select one of these options:

Automatic
Programmatic
Manual

(More on this shortly…)
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Applications 
Creating an Application

7. Set the Retention Period to 
indicate how long you want 
ViewDirect-ABS to retain the 
balancing items and cycle 
data contained in this 
application.

Default value “0” retains 
records indefinitely.
Duration is expressed in 
cycles or calendar time.
Expiration Date is calculated 
automatically.
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Applications 
Retention Periods

When an application’s retention period expires, the following 
items expire and become candidates for deletion:

Balancing items
Rule procedures
Cycles and runs
Control Totals
Run and trace log files
Data source records

Expired items are not deleted automatically. To delete expired 
items, open the ABS Monitor utility from the Start menu. 

Note: Items do not expire unless all their dependent items have also 
expired. For example, balancing item expires only when all its runs expire. 
Similarly, an application expires only when all its balancing items expire.
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Applications 
Creating an Application

8. Click OK on the 
properties dialog. 
The application you 
created appears in the 
applications tree.
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Creating an Application 
Hands-On Exercise

In this exercise, you will create an application for the 
sample exercise data included with ViewDirect-ABS.

1. Log in to ViewDirect-ABS.
2. In ABS Explorer, select File|New|Application.
3. In Name field of the Application Properties dialog, enter 

“Accounting_Reports.”
4. In the Description field, enter “Monthly Accounting Reports.”
5. Click the calendar icon next to the Starting date field, and 

select a starting date of “December 1, 2002.”
6. Leave the Cycle Type set to “Monthly.”
7. Leave the Advancing Type set to “Programmatic.”
8. Leave Retention Period set to “0” and the expressed in field 

set to “Cycles.”



ViewDirect-ABS 4.1

Copyright © 2006, Mobius Management Systems, Inc., All rights reserved. 
Confidential and proprietary information of Mobius Management Systems, Inc. 18/45

Module 3 - Applications and Balancing Items

Creating an Application 
Hands-On Exercise: Feedback

The Properties panel 
should look like this.
To save the application, 
click OK.
The application now 
appears in the tree:
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Applications 
Editing an Application

After you have created an application, you can 
open the properties panel again to view or edit some 
additional information.

Select the application, and click Edit Application.

The Application Properties dialog now includes 
additional information…
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Applications 
Editing an Application

Balancing Status
Initially “No Runs”
Then either “Balanced”
or “Out of Balance”

Current Cycle Value
Date or integer 
Based on cycle type 

Finishing Date
Calculated from:

Cycle starting date 
Cycle type.
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Applications 
Editing an Application

You can change the name, 
description, advancing 
type, and retention period 
of an existing application.
If the application is of the 
Manual advancing type, 
the Advance Cycle button 
becomes active.

Note: To advance the cycle 
of any application of 
Manual Advancing Type, 
you must open the 
properties dialog, and   
click Advance Cycle.
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Application Cycle Types and Advancing Types 
What is a Cycle?

The interval or frequency with which all balancing items 
in an application are to be balanced is known as a 
cycle, as in an “accounting cycle.”

This interval generally corresponds to the timeframe in 
which the balancing operations are executed, though 
not all cycle types are date-based.
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Application Cycle Types and Advancing Types 
Types of Cycles

There are two types of cycles:
Date-Based Cycles:

Daily
Weekly
Bi-weekly
Monthly
Quarterly
Annual

Sequential Cycles
Version 
Incremental
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Application Cycle Types and Advancing Types 
Date-Based Cycle Values 

Date-based cycle values:

Appear in the date format YYYYMMDD

Advance to a new cycle value when today’s date 
matches a specified date (automatic) or when 
instructed by a rule (programmatic).

Increment based on the Starting Date
For example, a monthly application with a starting date of 
May 15 increments to June 15, July 15, August 15, and so 
forth.
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Application Cycle Types and Advancing Types 
Cycle Advancing Types

Cycle Type: Defines the interval
Cycle Advancing Type: Defines how to advance

Date-based cycles can be advanced in any of the following ways:

Automatic: The cycle advances automatically based on the 
date.

Programmatic: A rule in a rule procedure advances the cycle 
when a defined  condition in the rule procedure  
is satisfied.

Manual: Admin or Power User clicks the Advance Cycle 
button on the Application Properties dialog.
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Application Cycle Types and Advancing Types 
Advancing Date-Based Cycles

When a date-based cycle advances, its cycle value increases by 
one unit of the calendar interval associated with the cycle.  

For example:

An annual cycle with the value 20060101 (January 1, 2006) 
advances to 20070101 (January 1, 2007).

A monthly cycle with the value 20060101 (January 1, 2006) 
advances to 20060201 (February 1, 2006).
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Application Cycle Types and Advancing Types 
Starting Date

When you define a new application, ViewDirect-ABS assumes 
today’s date as the Starting Date.  
You can change the Starting Date to another date.
ViewDirect-ABS increments cycles based on the Starting Date.

For example, if you define an 
annual cycle with a Starting 
Date of July 1 of this year, the 
next application cycle will 
begin on July 1 of next year.
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Application Cycle Types and Advancing Types 
Version Cycle Values 

Version cycle values:

Are expressed in any numerical format nnnnnnnn, 
such as 00000001 or 00000345.

Have no relation to any calendar dates.

Can advance whenever you want.
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Application Cycle Types and Advancing Types 
Advancing Version Cycles

Programmatic: A rule in a rule procedure advances the 
cycle when the rule procedure runs or a 
defined condition in the rule procedure 
is satisfied.

Manual: Administrator or Power User clicks the 
Advance Cycle button in the 
Application Properties dialog to 
advance the cycle.

Version cycles can be advanced using either of 
the following two methods
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Application Cycle Types and Advancing Types 
Advancing Version Cycles

When you advance a Version cycle, its value 
increases by 1.  

For example:

An incremental cycle with the value 00004319
advances to 00004320.
An incremental cycle with the value 20060101
advances to 20060102.
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Balancing Items 
Defining Balancing Items

A balancing item is a logical entity you define within 
ViewDirect-ABS that specifies: 

The data sources to be processed
The rule procedures to process them

Note that when you initially create a balancing item:
No rule procedures, policy names, or report IDs are 
associated with the balancing item.  
These values are populated when you deploy the balancing 
item to the appropriate rule procedure.
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Balancing Items 
Creating a Balancing Item

1. Right-click the application with which you wish to associate 
the balancing item; from the context menu, select 
New|Balancing Item. 
(Alternatively, select the application, and, from the Edit menu, 
select New|Balancing Item.)

To create a new balancing item in ABS Explorer, complete 
the following steps:
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Balancing Items 
Creating a Balancing Item

2. Complete the fields in the dialog 
as follows:
Enter a name in the Balancing 
item name field.
Enter a longer description or 
explanation in the Description
field.
Balancing Status — This field is 
informational only and cannot 
be edited.   The initial value is 
set to “Out of Balance.”
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Balancing Items 
Creating a Balancing Item

3. The final step in creating a 
balancing item is to deploy it 
by doing the following: 
Select the balancing item in 
the tree.
Click Deploy in the task bar.

In the deploy dialog, 
fill in the appropriate 
fields to associate 
the balancing item 
with a rule 
procedure.
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Balancing Items 
Editing a Balancing Item

After you deploy a balancing item in an 
associated rule procedure, you can 
right-click it (or use the Edit menu) and 
select Edit Balancing Item.

Now the Balancing Item Properties 
dialog displays additional information…



ViewDirect-ABS 4.1

Copyright © 2006, Mobius Management Systems, Inc., All rights reserved. 
Confidential and proprietary information of Mobius Management Systems, Inc. 36/45

Module 3 - Applications and Balancing Items

Balancing Items 
Editing a Balancing Item

The Balancing Item Type is based on the 
rule procedure you deployed. Its 
possible values are:

Visual Parser Balancing Item – when 
the rule procedure is of “Control 
Totals Balancing Rule Procedure/ 
Balancing ViewDirect Reports” type.
Data Source Balancing Item – when 
the rule procedure is of “Control 
Totals Balancing Rule Procedure/ 
Balancing Other Data Sources” type.
Reconciliation Item – when the rule 
procedure is of “Reconciliation Rule 
Procedure” type.

In ViewDirect-ABS 4.1, this field cannot 
be edited.  
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Balancing Items 
Editing a Balancing Item

The Policy name field displays 
the name of the policy that 
extracts data from a ViewDirect 
for Networks report. 

This field appears only for a 
“Visual Parser Balancing Item.”

You can edit this field to redirect 
the balancing item to another 
ViewDirect for Networks policy.
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Balancing Items 
Editing a Balancing Item

The Report ID field displays the 
name of the source report in 
ViewDirect for Networks. 

This field appears only for a 
“Visual Parser Balancing Item”
type.

You can edit the Report ID to 
direct the balancing item to 
another report.
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Balancing Items 
Editing a Balancing Item

The Primary rule procedure field 
displays the name of the 
associated rule procedure and 
the date and time it last ran. 

This is the rule procedure whose 
initial deployment determined 
the balancing item type.

This field cannot be edited.
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Balancing Items 
Setting Balancing Item Prerequisites

The properties dialog allows you to set one or more prerequisites – other   
balancing items that must balance before this item will balance.

1. Select the 
Prerequisites tab.

2. Select another 
balancing item in 
the Available items 
list on the left.

3. Select Add to add 
the item. The item 
appears in the 
Prerequisites list.

Note: If the current 
balancing item is a 
prerequisite, the related 
item appears here.



ViewDirect-ABS 4.1

Copyright © 2006, Mobius Management Systems, Inc., All rights reserved. 
Confidential and proprietary information of Mobius Management Systems, Inc. 41/45

Module 3 - Applications and Balancing Items

Balancing Items 
Grouping Balancing Items in Folders

You can create folders 
under an application      
and then group related 
balancing items together 
within these folders. 
(Under these folders, you 
could create additional 
nested sub-folders.)

A folder and the balancing items it contains 
inherit the properties of the parent application.
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Grouping Balancing Items in Folders 
How Folders Work

For example, if you have an 
application “Monthly Reports” with a 
Monthly cycle type and an 
Automatic cycle advancing type, 
then all the balancing items in all the 
folders contained by this application 
will have the same characteristics – 
as in the Sales, Operations, and 
Marketing folders in the example 
shown. 
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Grouping Balancing Items in Folders 
Creating a Folder

In the left pane of ABS 
Explorer, right-click the 
application or folder under 
which you want to create a 
new folder, and select 
New|Folder from the context 
menu.  (Alternatively, you 
can select File|New|Folder 
from the ABS Explorer menu.)  

The Folder Properties dialog 
appears…

To create a new folder, do the following:
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Grouping Balancing Items in Folders 
Creating a Folder

1. Enter the name for the folder 
in the Name field.

2. Enter the description for this 
folder in the Description field.

3. The Balancing Status is 
derived from the balancing 
items within the folder. 
All items must balance before 
the folder status is “balanced.”
This field is informational and 
cannot be changed. 
The initial value is “No Runs”
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Summary

You should now be able to:

Create and edit applications and folders.

Describe the behavior of cycles and runs.

Describe cycle types and advancing methods.

Create and edit balancing items.

Create a folder.
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